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Overview of Corticon Installations
This guide presents procedures for accessing, downloading, and running Corticon 5.7 installers, as well as
providing dynamic access to information about supported platforms. Links to the Progress Corticon
KnowledgeBase provide additional information about third-party software setup.
Progress® Corticon® is the Business Rules Management System with the patented rules engine that enables
you to automate sophisticated decision processes—without having to write code.

Progress Corticon products
Progress Corticon distinguishes its development toolsets from its server deployment environments.

• Corticon Studio is the Windows-based development environment for creating and testing business rules:
• When installed as a standalone application, Corticon Studio provides a complete Eclipse development
environment for Corticon in the Corticon Designer perspective. You can use this Eclipse installation
as the basis for adding other Eclipse tools.

• When installed into an appropriate existing Eclipse environment, Corticon integrates with installed Eclipse
tools to enable you to develop Corticon applications in the Corticon Designer perspective.
Note: Refer to the Corticon Installation Guide for details about integrating Corticon Studio into an existing
Eclipse environment.

• Corticon Servers implement web services and in-process servers for deploying business rules defined in
Corticon Studio:

• Corticon Server for Java is supported on various application servers, and client web browsers. After
you install it on a supported Windows platform, its deployment artifacts can be redeployed on various
UNIX and Linux web service platforms as Corticon Decision Services.
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• Corticon Server for .NET facilitates deployment of Corticon Decision Services on Windows .NET
Framework and Microsoft Internet Information Services (IIS).

• Corticon Web Console enables administration of multiple remote Corticon Servers. A Web Console
server is deployed into a Progress Application Server, and then is accessed by users through authenticated
web browser connections.

For details, see the following topics:

•

System requirements

•

Downloading Corticon installer packages

System requirements
Progress Corticon products are supported on a variety of platforms and third-party components.

Corticon Studio
Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix to review the
currently supported Corticon Studio operating systems, and Eclipse versions.
The target system for a Corticon Studio installation requires:

• Supported Windows operating system
• 8 GB System RAM (minimum of 2 GB available RAM)
• 650 MB disk space
• When an existing Eclipse will be used, a supported Eclipse version
Corticon Server for Java
Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix to review the
currently supported platforms and application servers. Also see the Corticon KnowledgeBase entry Corticon
Server 5.X sample EAR/WAR installation for different Application Servers for detailed instructions on configuring
Apache Tomcat, JBoss, WebSphere, WebLogic on all supported platforms.
The target system for a Corticon Server for Java installation requires:

• Supported Windows or Linux operating system
• When deploying on other platforms, a supported operating system and application server
• 8 GB System RAM (minimum of 2 GB available RAM)
• 600 MB disk space
Corticon Server for .NET
Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix for information
on supported .NET Framework and IIS versions, and the Corticon Knowledgebase article appropriate for your
target IIS/platform, as listed in the topic Preparing Corticon .NET Server resources for an IIS server on page
28.
The target system for a Corticon Server for .NET installation requires:
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• Supported Windows operating system
• Supported .NET Framework and Internet Information Service (IIS)
• 8 GB System RAM (minimum of 2 GB available RAM)
• 500 MB disk space
Corticon Web Console
Refer to the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix for information
on supported browser versions.
The target system for a Corticon Web Console installation requires:

• Supported Windows or Linux operating system
• 4 GB System RAM (minimum of 2 GB available RAM)
• Java option for MaxPermSize set to at least 256m
• 600 MB disk space
Note: When all three Server components are installed on one machine, the required space for the installation
is about 1 GB.

Downloading Corticon installer packages
The Corticon Studio installer package
For supported Windows machines: PROGRESS_CORTICON_5.7_STUDIO_WIN_64.exe

The Corticon Server and Web Console packages
Microsoft Windows
Corticon Server and Web Console 5.7 products for Windows -- Java Server, .NET Server, and Web Console
-- are packaged in executable installer applications and ZIP archives.
For supported Windows machines, download: PROGRESS_CORTICON_5.7_SERVER_WIN_64.exe
Zip Archives
Corticon Server and Web Console .war files are available in a Corticon Server .zip archive. Use it to install the
Server Console or Web Console on a supported application server without using the executable installers.
Linux
Corticon Server and Web Console 5.7 products for Linux -- Java Server, and Web Console – are packaged in
executable installer applications for supported Linux machines:
PROGRESS_CORTICON_5.7_SERVER_LNX_64.bin

Perform downloads
To download required Corticon installers:
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1. Get credentials to access and download packages on the Progress Software Electronic Software Download
(ESD) site, .
2. Connect to the ESD, log in, and then navigate to the Corticon 5.7 page.
3. Locate, download, and save the required installers to a temporary location accessible by the target machine.

10
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Preparing for a Corticon Installation
Before running installers
To avoid possible constraints on the installers, do the following:

• Confirm that you have Administrator permissions on the target machine - Administrator rights allow
the installer to copy all the Corticon files to their proper locations. You must have Administrator rights and
permissions to install this software. See your system administrator to obtain these rights.

• Obtain system access - Several Corticon features write files to the “home” directory structure. If the target
machine for the Corticon installation does not have read and write access to this directory, you need to
choose a directory location where Corticon will have both read and write access.

• Disable anti-virus, anti-malware, and anti-spyware protection applications - Before performing the
installation, consider temporarily disabling any anti-virus and anti-spyware software that may be running on
the target machine, as such software might interfere with correct installation.

• Review the supported platforms - Refer to the Progress Software web page Progress Corticon 5.7 Supported Platforms Matrix to review the operating system versions for Corticon Server and Corticon Studio
and supporting software.
For details, see the following topics:

•

If you are evaluating Corticon...

•

If you are upgrading Corticon...

If you are evaluating Corticon...
You can install Studio and Server, start them, and then get underway. The licensing will sustain you for a while:
Progress Corticon: Installation Guide: Version 5.7.1
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• Studio Licensing - Corticon embeds a ninety-day evaluation license that enables development of business
rules projects, as well as testing of the projects in an embedded test server. You must obtain Studio
development licenses from your Progress representative.

• Server Licensing - Corticon embeds a limited evaluation license that enables testing of rule modeling
projects on supported platform configurations. You must obtain server deployment licenses from your
Progress representative. The license included in the default Corticon Server installation has pre-set limits
on certain Corticon Server and Decision Service parameters. These limits are:

• Number of Decision Services – Up to 20 Decision Services may be deployed at any given time. This
means the sum total of all Decision Services loaded via .cdd files, Web Console, or APIs cannot exceed
20.

• Number of Rules – All rules in all deployed Ruleflows (that is, all deployed Decision Services) must not
exceed 500. A rule generally consists of a single Condition/Action Column or a single Action row in
Column 0. Filter expressions do not count because they only modify other rules.
Note: The Corticon Server log can capture errors and exceptions caused by expired or under-strength
licenses. These log messages are detailed in the Using Corticon Server logs section of the Integration and
Deployment Guide.
If you are Progress Corticon customer, you should have access to an unlimited license that will lift these
restrictions. If you are an evaluator, and discover that these limitations are preventing or inhibiting your
evaluation, contact your Progress Software representative to get a license with expanded capabilities.

If you are upgrading Corticon...
Existing Corticon users advancing to this release will want to know whether their existing products can co-exist
with the newer version, as well as any strategies for perpetuating the assets created in their current version.
If you have an existing installation of Corticon products on the target machine, backup all assets and workspaces,
and then do the following:

• For an upgrade of a 5.3.x, 5.4.x, 5.5.x, or 5.6.x installation to 5.7 - If you are upgrading from 5.3, 5.4,
5.5, or 5.6 installed software on the same machine, 5.7 will install to new location and run independent of
the other releases. You must manage any port overloads that might result from running both versions. If
you have a load balancing architecture, traffic can be redirected when a new Server version is installed next
to a previous version. This architectural setup will incur no down time. A general recommendation should
be to leave the previous version untouched until the new version is installed. It is good practice to backup
all workspaces before proceeding.
The topic Procedures for upgrading Corticon installations on page 29 presents a checklist sequence of tips
and techniques that will ensure stable, current functionality in upgraded Studios and Servers.

• For an upgrade of a 5.2 or earlier version 5 installation to 5.7 - An installed version of Corticon 5.2 or
earlier installed on the target machine must be uninstalled, then the appropriate Corticon 5.7 product installed.
We recommend that you consult with Progress Corticon Support or your Progress representative to discuss
your migration strategies for existing assets before you take action.

• For an upgrade of a 4.3 or earlier installation to 5.7 - Download and install Corticon Studio 5.3.0 or 5.4.0,
and then perform the procedures in its Corticon Migration Guide. Once completed, uninstall the 4.3 installation,
and install 5.7 where its upgrade utility can bring project assets up to date. We recommend that you consult
with Progress Corticon Support or your Progress representative to discuss your migration strategies for
existing assets before you take action.
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Installing Corticon Studio
There are several techniques for installing Corticon Studio:

• Running the Corticon Studio installer wizard on page 14, the typical use, which enables a complete Corticon
Studio Eclipse installation that can standalone, or be tailored into another Eclipse IDE on the same machine.

• Performing Silent Installations of Studio on page 17 that generates a file from an installer wizard run to let
you perform silent Studio installations on other machines.

• Installing Corticon Studio plugins into an existing Eclipse on page 18 which enables scripted installation of
Corticon Studio plugins into an existing Eclipse.

What Corticon Studio installers provide
The installer wizard package includes:

• Corticon Studio resources
• Eclipse Development Environment and Eclipse online documentation.
• Java Runtime Environment (JRE)
• Sample projects
• API documentation for extending Corticon
• Corticon Server runtime for use in testing rules you create in Corticon Studio
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Installation options
A new Corticon Studio install lets you choose to install it standalone, or to add its plugins to an existing Eclipse
4.5 installation.
For details, see the following topics:

•

Running the Corticon Studio installer wizard

•

Performing Silent Installations of Studio

•

Installing Corticon Studio plugins into an existing Eclipse

•

Increasing Corticon Studio memory allocation

•

Setting Studio to run in another language

Running the Corticon Studio installer wizard
The Studio installer will install or update Studio 5.7.

Installing or updating Studio 5.7
To perform a new installation of Corticon Studio 5.7:
1. Double click on the installer file, PROGRESS_CORTICON_5.7_STUDIO_WIN_64.exe, to launch the Corticon
Studio installer.
The installer opens in the installer wizard.
2. The first installer panel opens with information about the installer.

3. Click Next to continue.
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The License Agreement panel opens.

This panel displays the Progress Software End User License Agreement (EULA). Use the scroll bar at the
right of the screen to read the agreement content.
4. When you understand and agree to the terms, choose I accept the terms in the license agreement, and
then click Next to continue.
The Choose Install Folder panel opens.
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5. Specify the installation location. The default location for the installation directory and the work directory are
as shown above. (For the work directory, the default subdirectory under Users is the current username.)
Either accept the default locations, or specify each preferred (and different) location.
6. Click Next.
7. The External eclipse configuration panel opens:

• If you select Yes on this panel, the entry area for the External Eclipse location in which you want to
add Corticon Studio (in addition to a standard installation) is presented:
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Enter or browse to the location of the existing Eclipse 4.5 64-bit installation.

• If you leave the selection as No, a normal installation will proceed.
When you have decided which path to take, click Next to continue.
8. The Pre-installation Summary panel opens.

Confirm that your installation location has adequate disk space for the Corticon Studio components as well
as at least 100 MB of workspace.
9. Click Install to continue.
An installation status window opens to display the state of the installation process. When the process has
finished, the Install Complete panel opens.
10. Click Done to quit and close the installer.
The installation or update of Corticon Studio 5.7 is complete.

Performing Silent Installations of Studio
An unattended (silent) install requires that you first run an installation or updater in the installer wizard to capture
the selected options, and then use the captured response file on other targets to 'playback' the responses into
the installer without any user interaction.
To perform silent installations for Corticon Studio:
1. Run the Studio installer with your preferred locations and options to capture a response file, using the syntax
installer.exe -r file where installer is the preferred Studio installer, and file is the response
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file you will reuse. For example, PROGRESS_CORTICON_5.7_STUDIO_WIN_64.exe -r
C:\CorticonStudio64_57.responses
2. On other target machines, access the Studio 5.7 installer executable and the response file.
3. On those machines, run the installer using the syntax installer.exe -i silent -f file where
installer is the Studio installer, and file is your response file. For example,
PROGRESS_CORTICON_5.7_STUDIO_WIN_64.exe -i silent -f
C:\CorticonStudio64_57.responses.

Installing Corticon Studio plugins into an existing
Eclipse
These instructions apply when you want to install Corticon functionality into an installed 64-bit Eclipse IDE.
1. A Java Software Development Kit (JDK) is required for Corticon, not just a Java Runtime Environment
(JRE). If you do not have one installed locally, download and install a 1.7 or higher 64-bit version from the
Oracle Java website http://www.oracle.com/technetwork/java

Note: For the installation of the Corticon Studio plugins, you can use the JRE that Eclipse is using. In
Eclipse, choose Window > Preferences, then select Java > Installed JREs.
2. Download and perform a standard installation of Corticon Studio into a clean directory on the target machine.
This installation will provide the script and the required files for the integration into your target Eclipse
location.
3. In a Command Prompt window at the Corticon Studio's [CORTICON_HOME]/Studio location, check to
see whether JAVA_HOME is set. If not, set JAVA_HOME to the JDK root. For example: set
JAVA_HOME=c:\jdk1.7u67_64
4. Confirm that neither the installed Corticon Studio or the target Eclipse are running.
5. In the Command Prompt, run the integration script in the form:
integrateCorticon.bat –install

eclipse_target

where eclipse_target is the root directory of the target Eclipse installation.
Eclipse installs its required plug-ins.
6. To ensure that Corticon Ruletests can locate javac to compile rules, add the path of the JDK to your PATH
as the default Java to use. For example:
set PATH=%JAVA_HOME%\bin;%PATH%

7. Specify the Corticon work directory, the folder where you want Corticon to write its log and other temporary
files. For example:
set CORTICON_WORK_DIR=c:\corticon_work_dir
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8. When the script successfully completes, restart the Eclipse session, and then verify the installation by
selecting the menu command Help > About Eclipse. Click Installation Details to confirm that Progress
Corticon Feature is installed.
9. Open a project, and then run a Ruletest. A successful run indicates that the Java compiler is being accessed
correctly.
The integrateCorticon script enables other functions:
COMMAND SYNTAX AND OTHER OPTIONS
================================
Usage: integrateCorticon [OPTION] [TARGET_ECLIPSE]
Manage installation of Corticon plugins in an Eclipse install
-install
Install Corticon plugins in TARGET_ECLIPSE
-uninstall
Uninstall Corticon plugins from TARGET_ECLIPSE
-update
Update Corticon plugins in TARGET_ECLIPSE
-updateParams
Update Corticon plugins parameters in TARGET_ECLIPSE
-help
Display this message

Increasing Corticon Studio memory allocation
When working on large Rule Projects, you will get better performance by increasing the amount of memory
available to Corticon Studio.
To change Corticon Studio memory allocation after installation, do the following:
1. Edit the command file eclipse.ini located at [CORTICON_HOME]\Studio\eclipse
2. Change (typically, increase) the Xmx value (maximum memory setting). The default Xmx setting is 2 gigabytes,
specified as Xmx2g.

Setting Studio to run in another language
You can specify a preferred language for Corticon Studio. the options are:

• English (en - default)
• French (fr)
• Japanese (ja)
• Portuguese (Brazilian) (pt_BR)
• Spanish (es)
To set Corticon Studio to start in your preferred language:
1. Right-click on the Start menu item for Corticon 5.7 Studio, and then choose Properties.
2. In the properties dialog box, add the language option, -nl followed by the language value, as shown in this
example setting ja for Japanese:
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3. Click Apply, and then OK to set the change.
When you start Corticon Studio its labels are in Japanese, as illustrated:
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Installing Corticon Servers and Web Console
This section provides information about the installation procedures for the deployment and administration
components of Corticon Server as well as the Progress Application Server (PAS) -- a Web application server
based on Apache Tomcat -- that is used by the Java Server and the Web Console.
Note: Linux Installation - When you download and run the Linux server installer, you get shell (.sh) scripts
for start/stop and utility tools that correspond to the batch (.bat) scripts in a Windows installation.
There are several techniques for installing Corticon Server components:

• Running the Server and Web Console installer wizard on page 22, the typical use, which enables a complete
Corticon Server for Java, Corticon Server for .NET, and Corticon Web Console.

• Performing silent installations of Server components on page 26 that generates a file from an installer wizard
run to let you perform silent installations of Server components on other Windows machines.

• Performing command-line Linux installations of Server components on page 27 enables the Linux installer
to run from the shell as a command with parameters.

• Performing a manual installation of Server components: Corticon Server for Java and Web Console
are available in zip archives. Use them to manually install Corticon WAR/EAR files into a supported application
server on any supported platform. For details about installing Corticon into specific application servers, see
Corticon Server 5.X sample EAR/WAR installation for different Application Servers .

Considerations for Authentication
Confirm that servers that will host Corticon Server installations are enabled for authentication, and that Decision
Service administrators have the credentials to deploy to those servers.
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When you run the Corticon Server installer, the Progress Application Server (PAS) does not enable authentication
by default. To do so, see "Setting up authentication for secure server access" in the Integration and Deployment
Guide.
For details, see the following topics:

•

Running the Server and Web Console installer wizard

•

Performing silent installations of Server components

•

Performing command-line Linux installations of Server components

•

Preparing Corticon .NET Server resources for an IIS server

Running the Server and Web Console installer wizard
The Server installer will install or update Servers and Web Console to 5.7.
Note: You can install Corticon Servers and the Web Console on a machine that has a previous version installed.
Where a previous version is installed, you must manage any port overloads that might result from running both
versions. However, an installed version of Corticon Server 5.2 or earlier on the target machine must be
uninstalled, then Corticon Server 5.7 installed. Consult with Progress Corticon Support or your Progress
representative to consider your migration strategies for existing assets before you take action.
To create or update an installation of Corticon Servers (Java and .NET) and Web Console 5.7:
1. On the target machine, access the Corticon 5.7 installers you downloaded.
2. To open the Progress Corticon Server Setup Wizard:

• For Windows, double click on: PROGRESS_CORTICON_5.7_SERVER_WIN_64.exe
• For Linux, run: PROGRESS_CORTICON_5.7_SERVER_LNX_64.bin
The installer opens in the installer wizard. The first installer panel opens with information about the installer.
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3. Click Next to continue.
The License Agreement panel opens.

4. After you have read, understood, and agreed to the terms of the End User License Agreement, choose I
accept the terms of the license agreement, and then click Next.
The Choose Install Folder panel opens.
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5. The default installation directories are shown. To specify preferred directories on each line, either enter the
explicit path, or click Choose to browse to each preferred directory.
Note: For Linux installations, the work directory path must not contain spaces.
6. If you see the upgrade panel instead, Corticon Server components are already installed. You can add
previously unselected components but you cannot change the install location or uninstall existing components.

7. Click Next.
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The Choose Server Components panel opens.

8. Choose the one or more components you want to install at this time. Any components already installed are
chosen and grayed out. If you choose Corticon Server for .NETas one of the components, see the topic
Preparing Corticon .NET Server resources for an IIS server on page 28 for further instructions.
Note: The Linux installer does not enable a Corticon Server for .NET installation.
Click Next.
9. If you selected the Java Server or Web Console, the Corticon Port Numbers panel opens.
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10. If any of the preferred ports conflict with existing applications, you can change them at this time to an integer
value from 1024 to 49151. Be aware that the documentation references these ports as though the default
values, as shown, were accepted. Consult with your system administrator to identify alternate ports you
might use, or to reset the ports on the conflicting applications.
Enter your preferred port numbers, and then click Next. The Pre-Installation Summary page opens.
11. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so you can click
Previous to go back to a panel to make changes, or click Cancel to quit this installation procedure.
12. Click Install to continue. The installation status window opens. When done, the Install Complete panel
opens.
13. Click Done to complete the Corticon Server / Web Console installation and close the installer.
The installation and update of Corticon Servers and Web Console 5.7 is complete.
Note: Using an LDAP store for Web Console authentication - You can set up Corticon Web Console to
authenticate users using an LDAP server. See the topic "Using LDAP for Web Console authentication" in the
Web Console Guide.

Performing silent installations of Server components
An unattended (silent) install requires that you first run an installation in the installer wizard (Windows or Linux)
to capture the selected components and options, and then use the captured response file on targets on the
same platform to 'playback' the responses into the installer without any user interaction.
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Silent installations or updates for Corticon Server Components on Windows:
1. Run the Corticon Server for Windows installer with your preferred locations and options to capture a response
file, using the syntax installer.exe -r file where installer is the preferred Server installer, and
file is the response file you will reuse. For example:
PROGRESS_CORTICON_5.7_SERVER_WIN_64.exe -r C:\CorticonServer_57_WIN.responses
2. On other target Windows machines, access the Server 5.7 installer executable and the response file.
3. Run the installer using the syntax installer.exe -i silent -f file where installer is the
Server installer, and file is your response file. For example:
PROGRESS_CORTICON_5.7_SERVER_WIN_64.exe -i silent -f
C:\CorticonServer_57_WIN.responses

Silent installations or updates for Corticon Server Components on Linux:
1. Run the Corticon Server for Linux installer with your preferred locations and options to capture a response
file, using the syntax installer.bin -r file where installer is the preferred Server installer, and
file is the response file you will reuse. For example:
PROGRESS_CORTICON_5.7_SERVER_LNX_64.bin -r
/usr/corticon/CorticonServer_57_LNX.responses
2. On other target Linux machines, access the Server 5.7 installer binary and the response file.
3. Run the installer using the syntax installer.bin -i silent -f file where installer is the
Server installer, and file is your response file. For example:
PROGRESS_CORTICON_5.7_SERVER_LNX_64.bin -i silent -f
/usr/corticon/CorticonServer_57_LNX.responses

Performing command-line Linux installations of Server
components
A command-line install runs a Linux installation in a command shell as a text command with parameters.
To perform command-line installations for Corticon Server components:
1. On a supported 64-bit Linux platform, access the downloaded Linux installer binary file,
PROGRESS_CORTICON_5.7_SERVER_LNX_64.bin
2. In a shell, run the binary with the console option. For example:
# ./PROGRESS_CORTICON_5.7_SERVER_LNX_64.bin -i console

3. Follow the prompts to complete the installation via the command-line.
Note: For Linux installations, the work directory path must not contain spaces.

Progress Corticon: Installation Guide: Version 5.7.1
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Preparing Corticon .NET Server resources for an IIS
server
The runtime server for Corticon Server for .NET is Microsoft Internet Information Services (IIS), a distinct setup
into which you install and update with the latest Corticon Server for .NET resources.

• Obtain an appropriate Corticon license for Corticon Server.
• Confirm that your target machine meets the system requirements. See System requirements on page 8
for more information.

• See the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix for information
on supported .NET Framework and IIS.
See the instructions for "Setting up Corticon Server for .NET on IIS" in the "Deploying Web Services on .NET"
guide.
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Procedures for upgrading Corticon
installations
Stepping through tasks that optimize upgrades of Corticon Studios and Servers ensures that your files and
assets are synchronized with the updated product. These tasks are a checklist of good practices.
If your upgrade was a minimal step forward, such as a patch (such as 5.6.0.11 > 5.6.0.12), you should read
the patch notes to see if there are tasks to consider. For a Service Pack (such as 5.7.0 > 5.7.1), it is more likely
that there are changes in the product that you should handle, even though they might not present problems.
For a minor release -- especially a big step (such as 5.5.2 > 5.7.1) -- every one of these tasks should be
reviewed, considered, and performed.
Note: Do not copy the .war or .ear files from an older version's installation to a new one.
In the order of action:
ON STUDIO MACHINES

• Update Studio installations
• Update the Studio's brms.properties
• Update eclipse.ini and Java
• Update the Studio license file
• Upgrade assets
• Update desktop shortcut
• Package Decision Services
ON SERVER MACHINES
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• Undeploy the old Decision Services
• Update Corticon Server and Web Console software
• Update the Server's brms.properties
• Update the Server license files
• Clear browser caches that use the Web Console
• Deploy regenerated Decision Services
• Update IIS servers and set clienttype to IIS
• Stop load balancers and start the new server
ON STUDIO MACHINES
Install Studios
See Installing Corticon Studio on page 13

Update the Studio's brms.properties
Compare the brms.properties files that are currently in use. Any property adjustments you made in the
past, if still valid, should be copied into the newer installation. While a minor release installs into a separate
location, a service pack overlays an existing installation and does not touch an existing brms.properties .

Update eclipse.ini and Java
Some Studio installations benefit from tweaking the eclipse.ini, often for Studio memory settings. If you
are pointing to your preferred Java, it might not be optimal.

Update the Studio license file
A major release will likely require a new license file while minor releases typically do not. When you are provided
a license for Corticon Studioand Server, you receive a JAR file, CcLicense.jar. Save the file on the target
machine or at a location that is network-accessible to the installation. In this example, the license file that both
Studio and Server will use is placed at C:\licenses.
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To update a Studio license:
1. Select the menu command Window > Preferences.
2. Expand the Progress Corticon group. In the License File entry area, enter or browse to the location of
the license JAR:

Click Apply, and then click OK.

Upgrade assets
In Studio, be sure to upgrade all project assets. While you could do this file by file or project by project, it is a
good idea to advance all the assets you might work with in the current release. It is a good idea to run any
Ruletest or unit tests to see that the behaviors are as expected.

Update Desktop shortcut
Make changes to your desktop shortcut if you want your new Studio version to run in a different language.

Package Decision Services
Use any of the several techniques in Studio to package projects as Decision Services, and then stage them
for deployment on the new server installations.

Other considerations
• If you are advancing from 5.5 to 5.7.1, and using EDC Datasource metadata, regenerate the metadata.
• If you are advancing to 5.7.1, Advanced Data Connectors changed dramatically since its introduction in
5.6.1, the way its used in 5.7.0, and the Datasource configuration file in 5.7.1 to support an independent
query database.

ON SERVER MACHINES
Undeploy old Decision Services
Undeploy every EDS on the target servers.
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Install new Corticon Server and Web Console software
If you are using load balancers to carry the load during upgrade, take one of its peers offline, and stop it. Run
the installers, and then start the new Server.
Note: Other application servers - The .ear and .war files can be downloaded in the
PROGRESS_CORTICON_5.7_SERVER.zip package. The unpackaged files are typically installed in the Corticon
directory [CORTICON_HOME]\Server\Containers\{EAR/WAR}. Refer to the Progress Software web page
Progress Corticon 5.7 - Supported Platforms Matrix to review the currently supported UNIX/Linux platforms
and brands of Application Servers. Also see the Corticon KnowledgeBase entry Corticon Server 5.X sample
EAR/WAR installation for different Application Servers for detailed instructions on configuring Apache Tomcat,
JBoss, WebSphere, WebLogic on all supported platforms.

Update Server licenses
The Server requires you to copy the CcLiense.jar file, and then paste it to replace the existing file, as follows:

• Java server license:
• [CORTICON_HOME]\Server\lib\The license used for Server tasks and operations.
• [CORTICON_WORK_DIR]\Server\pas\server\webapps\axis\WEB-INF\libThe license deployed
to the runtime server. If you are managing a default Java server (PAS) from the Web Console, you can
perform this task through its "Editing Servers" in the Web Console Guide.

• When your installation is from the .ear and .war files for deployment onto other supported platforms
and application servers, place the license file adjacent to the Corticon JARs.

• .NET server license :
• [CORTICON_HOME]\Server .NET\samples\lib\The license used by the samples.
• [CORTICON_HOME]\Server .NET\webservice\lib\The license propagated to the IIS location by
the install utility..

• The IIS location, typically: C:\inetpub\wwwroot\axis\lib\The license at the IIS location. If you
are managing a .NET server from the Web Console, you can perform this task through its "Editing
Servers" in the Web Console Guide.

Update the Server's brms.properties
As with Studio, compare and update the brms.properties files on Java and .NET servers with consideration
that many properties are effective only on servers.

Clear browser caches that use the Web Console
For administrators that use the Web Console, have them flush their browser caches.

For .NET servers:
• Install to the IIS - Run install.bat to refresh the IIS server's libraries and samples. Answer Y to all the
overwrite choices. Then restart the IIS server.

• Set the Client Type - Change the setting in the brms.properties file that enables the Studio remote
tests and server utilities:
com.corticon.studio.client.soap.clienttype=IIS

For more information, see "Setting the Client Type" in the .NET Guide.
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• Copy the brms.properties file from the Corticon server root, paste it into the axis folder at the IIS
location, and thereafter apply updates to it there.
For more information, see the .NET Guide.

Deploy the fresh Decision Services
Deploy the newly created Decision Services to the new server.

Stop load balancers and start the new server
Use Web Console (or other techniques) to deploy the upgraded EDS files and license to the new Server. Bring
the other load balancers down, and then expose the upgraded server to carry the load. Uninstall old Servers,
and then upgrade and provision to be peers.
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6
Uninstalling Corticon Products
Uninstalling Corticon Studio or Corticon Server results in removing a complete major.minor version of those
products, including any service packs or hotfixes applied. It is not possible then to uninstall just a service pack
or hotfix.

Uninstalling Corticon Studio
To remove a version of Corticon Studio, do the following:
1. Close Corticon Studio.
2. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Studio 5.7.x to launch its uninstaller.
Note: You could initiate the same task directly by navigating to [CORTICON_HOME]\Uninstall_Progress
Corticon Studio 5.7, and then running Uninstall Progress Corticon Studio 5.7.exe.

The installed files in the Studio's [CORTICON_HOME] are removed. Files you created (including the complete
workspace) are NOT removed or replaced during this process.
If the Uninstaller program is unable to fully remove components (usually because they are open), it will display
messages, and might require a reboot to complete the process.

Uninstalling Corticon Server
The Corticon Server components -- Corticon Server for Java, Corticon Server for .NET, and the Corticon Web
Console -- use common installation directories. As such, you cannot choose to uninstall just selected components.
Uninstallation will remove all installed server components.
To uninstall Corticon Server on Windows:
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1. Stop Corticon Server.
2. Backup any files you want to retain.
3. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Server 5.7.x to launch its uninstaller.
Note: You could initiate the same task directly by navigating to [CORTICON_HOME]\Uninstall_Progress
Corticon Studio 5.7, and then running Uninstall Progress Corticon Server 5.7.exe.

To uninstall Corticon Server on Linux:
1. Stop Corticon Server.
2. Backup any files you want to retain.
3. In a command shell, navigate to [CORTICON_HOME]\Uninstall_Progress Corticon Studio 5.7,
and then run Uninstall Progress Corticon Server 5.7.bin.
The installed files in the Server's [CORTICON_HOME] are removed. Note that files you created are NOT removed
or replaced during this process. No server files in the [CORTICON_WORK_DIR] are removed.
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A
Corticon 5.7.1 Online Tutorials and
Documentation
TUTORIALS: Learn about Corticon from online lessons at the Corticon Learning Center.
DOCUMENTATION: About this release
What's New in Corticon Online Help
PDF

Describes the enhancements and changes to the product since its
last point release.

Corticon Installation Guide Online Help Step-by-step procedures for installing Corticon Studio and Servers
in this release on Windows and Linux platforms.
PDF

DEVELOPMENT DOCUMENTATION: Define and Model Business Rules
Rule Modeling Guide Online Help PDF Introduces how business rules are modeled in Corticon Studio
including the creation of Vocabularies, Rulesheets, Ruleflows, and
Ruletests. This is the starting point for new rule modelers.
Quick Reference Guide Online Help
PDF

Reference guide to the Corticon Studio user interface, including
descriptions of all menu options, buttons, and actions.

Rule Language Guide Online Help PDF Reference information for all operators available in the Corticon Studio
Vocabulary.
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Extensions Guide Online Help PDF

Detailed technical information about the Corticon extension framework
for extended operators and service callouts.

Javadoc for Extensions API Javadoc Complete Java API reference for Corticon Extensions.

DEPLOYMENT DOCUMENTATION: Run Decision Services on Servers
Integration and Deployment Guide
Online Help PDF

Provides details on deploying and managing Corticon Decision
Services. Start here to learn about the options for deploying Corticon,
the best practices for managing your deployment, and the APIs for
integrating Corticon with clients executing rules.

Data Integration Guide Online Help
PDF

Provides details on how to integrate Corticon with external data
sources and how to use Corticon for batch rule processing. Includes
details on Corticon EDC and ADC features for accessing data from
Decision Services.

Web Console Guide Online Help PDF Presents the Corticon Web Console which can be used to manage
your Corticon deployment. This GUI interface simplifies the
management and monitoring of Corticon servers and Decision
Services.
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Deploying Web Services with Java
Online Help PDF

Provides details on deploying Corticon as a REST or SOAP web
service on Java application servers.

Deploying Web Services with .NET
Online Help PDF

Provides details on deploying Corticon as a REST or SOAP web
service on Microsoft IIS.

Javadoc for Corticon Server API
Javadoc

Complete Java API reference for Corticon Server.
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